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Alkusanat

Tamén oppaan tarkoitus on antaa kédestd pitden ohjeet rakenneyhtidlomallien rakentamiseen
LISREL ohjelman avulla. Rakenneyhtidlomalleja kantapdin kautta oppineina ja kursseja kéy-
mélld havaitsimme ettd timéntyyppiselle oppaalle on suuri kysyntd etenkin tutkijoiden ja jat-
ko-opiskelijoiden keskuudessa. Nykyéddnhdn suurin osa kyselytutkimuksista akateemisella

puolella on mallien rakentamista ja testaamista rakenneyhtélomalleilla.

T4mé opas on suunniteltu ennen kaikkea LISRELi4 vdhén kiytténeille tai tdysin uusille kéyt-
tdjille. Keskitymme kuvaamaan selkedsti pddkohdat ilman tilastotieteeseen syvéllisemmin
menemistd. Toivomme miellyttdvid lukuhetkid oppaan parissa. Uskomme ettd sen avulla
my0s LISRELii ennen kéyttimattomét tutkijat saavat aikaan nopeasti ja helposti toimivia ra-

kenneyhtidlomalleja.

Lisétietoa: LISREL ohjelmasta 16ytyy kattavat ohjeistukset: http://www.ssicentral.com

Jyviskyldssd ja Oulussa lokakuussa 2007

Heikki Karjaluoto & Jouni Juntunen



Aineiston valmistelu

Ennen aineiston tuomista LISREL ohjelmaan, kannattaa siihen tehdd SPSS —ohjelmalla seu-

raavia “’viimeistelyja”.

Puuttuvien havaintoarvojen estimointi (Missing Values)

Tédmai ohje olettaa tutkimusaineiston olevan tulkittavissa mitta-asteikolliseksi. Konservatiivi-
set tilastotieteilijit pitdvat kuitenkin Likert-asteikkoja, kouluarvosanoja yms. jérjestysasteikol-
lisina. Mikaéli mittarit tulkitaan jérjestysasteikollisiksi, on puuttuvat havainnot joko poistettava
tai tdydennettivi niille sopivilla menetelmilld. Yleensé taloustieteen julkaisut hyviksyvét mit-

ta-asteikollisen tulkinnan, mutta tima on syytd varmistaa etukéteen.

Puuttuvien havaintoarvojen (Missing Values) estimointi (timéa proseduuri voidaan myds tehda
LISREL ohjelmassa mutta sitd ei tissd oppaassa kdydd tarkemmin ldpi). Puuttuvia havainto-
arvoja ovat yleensa tyhjat vastaukset ja ”En tiedd/En osaa sanoa” vastaukset, jotka kannattaa
viimeistddn tdssd vaiheessa analyysia koodata puuttuviksi havaintoarvoiksi. SPSS -
ohjelmassa puuttuvien havaintoarvojen estimointi kannattaaa tehdd "EM (expectation-
maximization)” menetelmaa kayttéden. Muuttujat joiden puuttuvat havaintoarvot halutaan
estimoida (yleensd kaikki joita LISRELissé aiotaan kdyttdd) siirretdéin avautuvassa ikkunassa
joko kohtaan Quantitative Variables tai kohtaan Categorical Variables. Yleensé taloustieteis-
sd (muuttujien tulkinnasta riippuen) myds jérjestysasteikollisia muuttujia voidaan késitelld

mitta-asteikollisina ja siirtdd ne ylempain laatikkoon.

7.sav [DataSet1] - SPSS D4 M Missing Value Analysis E‘
POEEEN Graphs  Utilitiss Wi lPercvaluez. My op & Quantitative Variables:
Reports » of M Percvalue3. | am b iIEvaIuate the suitat # -
. " dlPercaled The o il M sms)
Descriptive Statistics 3
oM Trustl. My operatc D dMMS [MMSE] E stimation
Tables 4 .
oM Trust2. Basedonr dV|deo message [Vi [ Listwise
Compare Means 4 o/ M Trust3. My operatc ilLEIler [Letter] v [ Paitwise
General Linear Model 3 ol Trusta. My operste EF . 2
Mixed Models 3 o Trust5. My operate Categorical Variables: IR i
Carrelate [3 oM TrustE. My operatc EgrEssion
Regressian » M FREL1. *hen comg
" o M RELZ. When a cu: I:l
Loglinear 3
Classif R o M REL3. Company pr
assiy i M REL4. Services (e
Data Reduction 4 oM REST. Customers .
Seale 4 JTHRES2 Customer =
Nonparametric Tests 3 JHRES3 Customer = Case Labels:
Time Series » JHRES4. Custorner s ¥ |:|
Survival 4 Use Al Variables
Multiple Response »
Missing Value Analysis. . I oK ] [ Paste I [ Fieset ] l Cancel ] l Help ]
Complex Samples 3

KUVA 1. Puuttuvien havaintoarvojen estimointi



Kun muuttujat on siirretty Quantitative Variables valikkoon valitaan menetelméksi EM ja
klikataan EM painiketta, jolloin avautuvasta kuvasta Missing Value Analysis: EM voidaan
uusi aineisto tallentaa eri nimelld. Ndin kannattaa tehda siksi, ettd alkuperdinen aineisto séilyy
ja sitd voi palata muokkaamaan tarvittaessa. Dummy —muuttujien osalta kannattaa miettia
ovatko estimoidut arvot mielellditd tutkimusongelmaa ajatellen vai tulisiko puuttuvat dummy

—muuttujat sisdltdvat vastaukset hylétd kokonaan.

| Missing Value Analysi | M Missing Value Analysis: EM E

ﬂﬂESd. Customer s # i_u::‘intita“"’e Variables: Diztribution
4557, The behavi TANT. Wwebsite iz . e () Normnal
JHA552 You feel sal | Sl TANZ Website iz OM
553 Customer st : ol TN website i E stimatian Mired nomal
ﬂASSﬂL Employees ! d:l TAN4. Website is [] Listwise I:l
f:ll EMP1. Compary g i 4 TANS. [New Varial | [ Paiwise |:|

EMP2 The Emphjj s nois Wl =
H:IEMP3- The comps Cateqgorical Variables: et ) ,

SR N ey ) Student's t

JHEMP4. The emplay l:l
;[I EMPE. Customer s
& Gender [GEM] D
Il 4ge [4GE] M awirnum iteratiors:
&Marital statug [MAF L
Sl Househald size [HI et TA _l Save completed data

S wimum Categories: |2 _
&P Ession [ ! . (%) Create a new dataset
ol Morthly income (i Case Labels:
A Residence [RES] ¥ | D | | Dataset name: |hesetest

Use All Variables O whiite a new data file

’ (n] 4 ” Paste ” Feset ” Cancel ” Help ]

KUVA 2. EM menetelma

Kun puuttuvat tiedot on estimoitu, ovat estimoidut puuttuvien havaintoarvojen arvot yleensi
useiden desimaalien mittaisia. Téstd syystd kannattaa useimmiten estimoidut lukuarvot kooda-
ta uudelleen kokonaisluvuiksi. Tdéma tapahtuu kohdasta Transfrom > Recode > Into Same Va-
riables. Jos muutettava muuttuja on alun perin esimerkiksi viisiasteikollinen (1-7) tapahtuu

uudelleenkoodaus siten ettd muutetaan muuttujan arvot kokonaisluvuiksi seuraavasti:

Recode into Same Variables: 0ld and New Yalues @
Humeric Variables 0ldValue Hew Value
ol Coal oy | bslisve ﬂAlanﬂ I heve & rea] O Value @Value: | |
ol CoaLays. | prefer L2, e the Feh T o
Systemermissing
dllConaloyl. | have Ll AttLoy3. My operator's Fyoy .
ol Canaloy2 | neaty — E ol AftLopd, Overall, I'm s O Systemmissing
oill Conaloy3 | have Aoy | didke the o © System of user-nissing s N
Canalopd, R
i AZTD;" ‘ 'e::;a‘ O Range: Lowest th 1 433933593359339998 - 1
15 thns 2 495335559909990935 - 2
allActloy2 | think I ST o 1 25 thru 3.439399999302339395 - 3
lalond ki (i) optont caeselcton condton 3 acpiaaaoosamsean | 5
[optional case selection condition] 5 thiu 5. >

allActlopd el othe 7 |55 thru 5,493393999933999593 >

O Rangs, LOWEST thiough value: &2 i Highesl 2.

() Rarge, value thsugh HIGHEST

O #lather values [contine ] [ cancel | [ Hep |

KUVA 3. Muuttujien uudelleenkoodaus



Eli rekoodataan kaikki arvot véliltd pienin-suurin kokonaisluvuiksi 1-7. Ndin syntyvé aineisto
on kokonaisluvuista koostuva, vastaa alkuperdisen aineiston muotoa, ja soveltuu hyvin vieti-
véksi Lisreliin. On hyvéd huomioida, ettd vaikka SPSS:n asetukset ovat siten etteivdt desimaa-

lit ndy muuttujaikkunoissa, niin arvot voivat silti siséltda useita desimaaleja.

SPSS aineiston avaaminen LISRELissa

SPSS aineisto voidaan tuoda sellaisenaan LISRELin Prelis palikkaan, joskin suositeltavia
muita tapoja aineiston tuomiseen on tarjolla kuten aineiston tallentaminen SPSS ohjelmassa
muuhun kuin spss.sav muotoon. Yleensd télld ei kuitenkaan ole merkitystd missd muodossa
aineisto tuodaan jos puuttuvat havaintoarvot on estimoitu. Ndin LISREL osaa tulkita aineiston
kaikki muuttujat oikealla tavalla. Mikili aineisto vieddin mittareiden nimineen Lisrel tai Pre-
lis ohjelmaan, on erittdin tirkedd muuttaa mittareiden nimet maksimissaan kahdeksan merkkia
pitkiksi, koska muutoin Lisrel -ohjelmisto voi tulkita aineiston védrin. Jos taas aineisto siirre-
tadn ascii.dat muotoisena, on huomioitavaa, ettd desimaalipilkut tulee muuttaa desimaalipis-

teiksi.

Kéynnistetddn LISREL ohjelma. Valitaan File -> Import Data. Valitaan avattavan tiedoston
muodoksi SPSS (*.sav), haetaan kansio johon SPSS.sav tiedosto on tallennettu ja avataan se
jolloin LISREL aukaisee PRELIS ohjelman. Téssd vaiheessa ohjelma pyytdd antamaan nimen

tallennusta varten aineistolle:

Save in: | I Aineistat ﬂ £% -

[)dna data
[IYRE aineisto

File name: |
Save as type: |F'F|ELIS Drata [ psf] j Cancel

KUVA 4. Aineiston tuominen ja tallentaminen PRELIS ohjelmaan



Anna aineistolle nimi jolloin PRELIS ohjelma avautuu:

5 LISREL Windows Application - [hesetesti_tuhoa. psf]

[ File Edt Data Transformation |5 raphs Multievel SurveyGLIM View ‘indow Help NEF)
Dl m| || =LK
qd [ [ ER
coGll | coglz | coeL3 | cogL4 AFFL1 AFFL2 AFFL3 AFFL4 AFFLS CONLI CONL2 coNis | ¢
1 6.000 6.000 6.000 5.000 5.000 5.000 5000 7.000 6.000 5000 5.000 5000+
2 4,000 6,000 7.000 6000 6,000 5,000 B.000 5,000 6,000 5.000 2,000 5,000 | }
7.000 7.000 7.000 7.000 7.000 7.000 7.000 7.000 7.000 7.000 7.000 7.000
7,000 7,000 1.000 7.000 1.000 7.000 7000 7,000 1,000 £.000 7.000 1.000
6,000 7,000 5,000 7,000 7,000 7,000 5,000 7,000 7,000 5,000 5,000 7,000
4,000 4000 4000 4,000 7.000 4000 5000 5,000 7,000 3.000 4,000 7.000
? 4,000 5,000 6,000 5,000 6,000 5,000 5,000 6,000 6,000 4.000 6,000 6,000
8 4,000 4000 5000 2000 7.000 5.000 4000 4,000 2000 6.000 5.000 4,000
] 5,000 5,000 7.000 5000 7.000 5000 5000 5,000 7,000 4000 5000 7.000
4,000 5,000 5,000 5,000 5,000 5,000 5,000 7,000 6,000 5,000 5,000 3,000
5,000 5,000 2,000 5000 1.000 7.000 7000 7,000 1,000 £.000 7.000 2,000
6,000 6,000 5,000 5,000 5,000 5,000 5,000 7,000 6,000 7,000 5,000 5,000
3,000 3000 7.000 3.000 7.000 5.000 5.000 5.000 5,000 6.000 5.000 5000
11 7.000 7.000 7.000 2.000 7.000 7.000 B.000 5,000 7.000 5.000 2.000 7.000
15 2,000 2000 5000 2000 3000 2000 2.000 2,000 5000 2000 3000 5.000

KUVA 5. PRELIS ohjelma

Seuraavaksi aloitetaan analyysin pohjaksi tarvittavan matriisin teko. Téssd vaiheessa tarvitaan
my0s tieto siitd, millaista teoreettista mallia aiotaan testata, mikéli ei olla tekeméssd pelkis-
tadn eksploratiivistd faktorianalyysid. Valitaan Statistics -> Factor Analysis ja siirretddn

muuttujat jotka halutaan malliin ottaa mukaan vasemmasta sarakkeesta oikealle.

: )

I

Cancel |

Output Options

Murnber of Factars:
[Optional:)

—

[ Factar Scares

Syntax | Fun |

To zelect more than one vaniable at a time hold down the

I oment b atris

W Save to file:

|hese_acu'v{

[ Print in awtput

Aspmptobic Yariances

[ Save tofile: [ Print in output

Data

Wariable List: Select a subset of
A551 ¥ Wariables (Optional) |Covariances j [ Save the hansformed data ta file:
A552 ACLT .
A5S3 AL ”~ Iw Savetofile: [~ LISREL system data |
A554 ACL3 h
EMF ACLA jhese_cov Width of fields: |15
EMP2 ACL5
Emﬁi Select > ACLE Means Murnber of decimals: — |E
SAT1
CAT2 [ Save to file:
SAT3 Murnber of repetiions: |4
SAT4 |
SATH [ Rewind data after each repetiion
REL1 Standard Deviations W Er
ﬁE!.E " [ S ave o file: Print bivariate frequency tables
| [v  Print tests of underlying bivariate normality
(¢ ML Factor Analpsiz
L"SEETA " MINRES Factor Analpsis ; ; ; r
g v (" Principal Component &nalysis Azpmptotic Covanance b atrix ™ Wide print

[+ Random seed

[ Setseedto |123456

QK | Cancel |

CTRL key while clicking on the variables to be zelected

KUVA 6. Faktorianalyysin ja kovarianssimatriisien tekeminen

Painetaan ”Output Options” painiketta jolloin avautuu ”Output” ikkuna. Output ikkunassa va-
litaan kohdasta ”Moment Matrix” ”Covariances” (tai Correlations™) ja rastitetaan ruutu ”Sa-

ve to file” ja annetaan tallennettavalle kovarianssi/korrelaatiomatriisille nimi.



Mikaéli aineisto koostuu jarjestysasteikollisista muuttujista, kannattaa analyysin pohjaksi valita
korrelaatiomatriisi (Correlations) kuten Joreskog & Sorbom LISREL oppaissaan kehottavat.
Jotkut tutkijat kuitenkin kéyttdvét ldhes aina aineiston ollessa hieman suurempi kovarianssi-
matriisia. Myods LISREL 8.7 ohjelman ohje-esimerkissd tehdddn ei-normaalisti jakautuneille
jarjestysasteikollisille muuttujille kovarianssimatriisi joten sen kdyttd varsinkin isommilla ai-
neistoilla on myds hyviksyttavad. Mikéli kidytetddn kovarianssimatriisia, tulisi kuitenkin Pre-
lis tulosteesta tarkistaa, noudattavatko muuttujat normaalijakaumaa. Itse mallissa selittdvien
muuttujien ei tarvitse noudattaa normaalijakaumaa (Huom. esim. dummy muuttujat), mutta
selitettdvien muuttujien tulisi olla normaalijakautuneita. Myds normaalijakauman noudattami-
sen suhteen eri journaalit noudattavat eri kdyténtdjé, joissakin normaalisuudesta ei mainita
mitddn kun taas jotkin journaalit voivat olla siitd hyvinkin tarkkoja, eli selviti jélleen kerran

etukéteen, miten aikomassasi julkaisussa kéytintd on ollut.

Mikaili analysoitavat muuttujat eivit noudata normaalijakaumaa (yleensi jarjestysasteikollis-
ten muuttujien kohdalla ndin on), yksi vaihtoehto on valita myo6s kohta ”Asymptotic Cova-
riance Matrix” ”Save to file” ja antaa tiedostolle nimi. Asymptoottista kovarianssimatriisia
suositellaan kaytettdviksi myos erittdin suurilla aineistoilla (yli 2.000 havaintoa). Kannattaa
erottaa tallennettavat tiedostot nimiensa perusteella siten ettd muistaa myohemmin kumpi ko-

varianssimatriiseista on tavallinen ja kumpi asymptoottinen.

Korrelaatiomatriisia kiytettdessd Prelis ohjelma laskee jarjestysasteikollisten mittareiden vé-
lilld vallitsevan polykoorisen korrelaation, mitta-asteikollisten muuttujien vélille Pearsonin
korrelaatiokertoimen ja edellisten sekoitusten vilille polyseeriset korrelaatiot. Yleensa kysely-
tutkimukset koostuvat Likert-asteikollisista mittareista (mielipiteet, asenteet, 1-5 asteikot, 1-7
asteikot jne.), jotka taloustieteissd useimmiten tulkitaan mitta-asteikollisiksi. My0s niille kor-
relaatiokertoimien hyviksyttdvyydestd Prelis ohjelma antaa tulosteen. Mikéli tulosteesta sel-
vidd, ettd jollakin tietylld mittarilla on ongelmia useiden muiden mittareiden suhteen, tulisi

kyseinen mittari hyldtd. Yksittdisen ongelman vuoksi mittareita ei kannata hylata.

Seuraavaksi painetaan ”Factor Analysis” ikkunasta kohtaa ”Run” jolloin PRELIS tekee ana-
lyysiin valituille muuttujille faktorianalyysin. Isoilla aineistoilla analyysi saattaa kestdd tovin
joten kannattaa odotella kérsivéllisesti. Kun analyysi on valmis tekee PRELIS ohjelma .OUT

tiedoston jota tarkastelemalla saa yleiskésityksen minkilainen faktorianalyysi syntyi.



£ LISREL Windows Application - [hesetesti_tuhoa.OUT]

[JFie Edt options Window Help
D|e(es|m| & ||| alal 2|
I Usg@== ==

TIME: 12:08

BY

7383 N. Lincoln Awvenue

|PRELIS SYMTAX: Can be edited

kyselysAineistotihesetesti_tuhoa PSF

FA
ol MA=CM SM=hese_cov AC=hese_acow XM

Total Sample Size = 1388

Univariate Marginal Parameters

Variable Mean St. Dev. Thresholds
ACLT 4.076 2.160 0.000 1.000
ACLZ 4.748 2,53 0.000 1.000
ACL3 0.591 1.007 0.000 1.000
ACL4 3.289 2.318 0.000 1.000
ACLS 2.8942 2.328 0.000 1.000
ACLB 6.101 2.8977 0.000 1.000
SAT1 3.217 1.834 0.000 1.000
SAT2 3.286 1.873 0.000 1.000
SAT3 2.688 1.6594 0.000 1.000
SATY 5.813 2.636 0.000 1.000
SATS 3.872 1.730 0.000 1.000
REL1 7.419 2.938 0.000 1.000
REL2 5.967 2.273 0.000 1.000
REL3 7.009 2.822 0.000 1.000
REL4 8.060 3.342 0.000 1.000
EMP1 3.403 1.824 0.000 1.000

s R RO s s RO s s s

DATE: 089/11/2007

PRELIS 272

Karl G. Jareskog & Dag Sdrbom

This program is published exclusively by
Scientific Software International,

Inc

Suite 100

Lincolmood, IL 60712, U.5 A
Phone: (B00)247-6113, (B47)675-0720, Fax
Copyright by Scientific Software International, Inc
Use of this program is subject to the terms specified in the
Universal Copyright Convention
Wehsite: www. ssicentral.com

The following lines were read from file U:\Omat
tiedostotiHankkeet \FUMMAS \Kenttdkokeet\DNA kyselyhAineistotihesetesti_tuhoa.PR2

.738
836
505
740
541
127

.798

.870

.748

.oo7

420

241

.87

L9681

989
613

KUVA 7 .0OUT tiedostonakyma

(B47)A75-2140
1981-2005

S¥='U:\0nat tiedostoti\Hankkeet\FUMMASYKenttdkokeet\DNA

PRI 00 03 R 60 R 00 R G0 0D 0O R G0 R 0 R

642
161
228
286
740
380
026
701
422
778
0z0
933
797
422
590
428

SE 36 39 40 41 42 43 44 45 46 47 48 76 77 70 79 B0 89 590 81 53

RSN RN Y L S SNy A LSy )

594 85 96

748
553
772
663
gad
G386
072
877
917
624
527
167
743
612
914
586

(RS RN = R NIV SN RN N Y

387
6545
234
466
775
524
456
397
084
257
911
273
263
853
119
198

Seuraavaksi aletaan rakentaa rakenneyhtdlomallia. OUT —tiedoston alusta ndkee mihin dsket-

tdin luodut kovarianssimatriisit on tallennettu. Ne kannattaa ensin hakea C —aseman juureen

koska LISREL syntaksiin on tdisevéa kirjoittaa pitkid hakemistopolkuja. Luodaan C:n juureen

esimerkiksi kansio “’Lisreldatat” tms. Kopioidaan kovarianssimatriisit tdhan luotuun kansioon.

Valitaan seuraavaksi OUT. ikkunasta (tai PRELIS) ikkunasta File -> New -> Syntax only. Nyt

luodaan ns. SIMPLIS tiedosto (.LS8), jolla rakenneyhtdlomalli spesifioidaan. Tédssd kannattaa

kayttdd valmista tiedostopohjaa esim. titd (jos koneella on aiempia SIMPLIS tiedostoja vali-

taan File -> Open):

Huomioitavaa on, ettei muuttujien nimet saa olla 8-merkkid pitempid, eiko siséltdd “aakko-

sid”. Koodissa huutomerkki aiheittaa rivin alussa sen, ettei kyseisti rivid lueta ja huutomerkki

on tdmén vuoksi erittdin kdytdnnollinen mallia muokatessa.



RAKENNEYTALOMALLI TESTI

Observed Variables

ACL1 ACL2 ACL4 ACL5 ACL6 CPS1 CPS2 CPS3 SOVA1 SOVA2 SOVA3 TRU1 TRU2 TRU3 TRU4
TRU5 TRU6 REL1 REL2 REL3 REL4 RES1 RES2 RES3 RES4 ASS1 ASS2 ASS3 ASS4
Correlation Matrix from file C:\Temp\dnal6cor

Asymptotic Covariance Matrix from file C:\Temp\dnal6acov

Sample size 1385

Latent Variables

COGL AFFL CONL ACL ACLR CPS FUVA EMOV SOVA TRU SQ LOY PEVA
Relationships

ACL1 ACL2 ACL6 = ACL

ACL4 ACL5 = ACLR

CPS1 CPS2 CPS3 =CPS

SOVA1 SOVA2 SOVA3 = SOVA

TRU1 TRU2 TRU3 TRU4 TRU6 = TRU

REL1 REL2 REL3 REL4 RES1 RES2 RES3 RES4 ASS1 ASS2 ASS3 ASS4 = SQ
CPS =SQ

TRU = SQ

ACL =CPS

TRU = CPS SOVA

ACL = TRU CPS SOVA

ACLR = ACL

LISREL OUTPUT: SC WLS MI MR AD=OFF

Path Diagram

End of Problem

Kohtaan ”Observed Variables” kirjoitetaan muuttujien koodit siten kuin ne PRELIS ohjel-
massa esiintyvat. Mikéli kdytetddn pelkkad kovarianssi/korrelaatiomatriisia, niin tdssid nime-
tddn mittarit. Tdhén kohtaan ne pitdd my0s laittaa samaan jérjestykseen kuin faktorianalyysis-
sa ne laitettiin. Jos et endd muista mitd muuttujia otit analyysiin mukaan 16ytyvét ne OUT tu-

losteesta. Seuraaville riveille madritellddn mistd kovarianssimatriisit 10ytyvét:

Covariance Matrix from file C:\MyTemp\dnal6cor

Asymptotic Covariance Matrix from file C:\MyTemp\dnal6acov

Kohtaan “Sample size 1385 kirjoitetaan .OUT tulosteen alusta nihtdvi aineiston koko.
Mikaéli puuttuvat havaintoarvot on estimoitu aiemmin tulee tdhin sama arvo kuin on vastaaji-
en madrd kyselyssd. Seuraavalle riville maéritelldén latentit muuttujat eli faktorimuuttujat.

Téssé tapauksessa teoreettinen malli rakentuu kuudesta faktorista seuraavasti:

10



Action
loyalty

SErViCE
quality

Eecommend

Customer

parceived
sacrifices

KUVA 8. Teoreettinen malli

Malli on rakennettu seuraavanlaisen kyselylomakkeen pohjalta:

Service Quality (Cronbach’s alpha: .963) Mean s.d.
REL1. When company promises to do something by a certain time they do so 6.12 | 1.20
REL2. When a customer has a problem the company shows a sincere interest 6.32 | 1.11
in solving it

REL3. Company performs the service right first time 6.16 | 1.17
RELA4. Services (e.g. call center) works at the time they promise to do so 6.29 | 1.16
RES1. Customers are told exactly when services will be performed 6.00 | 1.19
RES2. Customer service is fast 6.14 | 1.26
RES3. Customer service give prompt service to you 6.14 | 1.15
RES4. Customer service are never too busy to respond to your requests 5.96 | 1.27
ASS1. The behavior of employees of customer service instills confidence in 6.01 | 1.18
you

ASS2. You feel safe in your transactions with the company 595 | 1.16
ASS3. Customer service employees are consistently courteous to you 6.11 | 1.10
ASS4. Employees in the customer service have the knowledge to answer in 6.23 | 1.08

your questions

Lahde: Mukailtu Cronin and Taylor (1992); Zeithaml et al. (1988)

Social value (Cronbach’s alpha: .971) Mean Sd
SOVAIL. My operator's brand would improve the way | am perceived 3.20 | 1.63
SOVAZ2. My operator's brand would help me make a good impression on other 3.16 | 1.61
people

SOVAZ3. Customers of my operator are socially appreciated 3.17 | 1.59

Lihde: Wang et al. (2004)

Customer perceived sacrifices (Cronbach’s alpha: .897) Mean Sd
CPS1. My operator's products and services are reasonably priced 499 | 141
CPS2. My O's products and services are value for money compared with that 4,82 | 1.30
of major competitors

CPS3. The choice of transacting with my O is a right decision when price and 519 | 1.34

other expenses are considered

Lihde: Wang et al. (2004)
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Trust (Cronbach’s alpha: .949) Mean Sd

TRUL. My operator is very honest 4.76 | 1.33
TRU2. Based on my experience, my operator is very trustworthy 5.05 | 1.29
TRU3. My operator is very reliable 4.82 | 1.29
TRU4. My operator takes its customers interests into account in its business 4.66 | 1.28
TRUS. My operator's marketing is truthful 4.84 | 1.37
TRUG6. My operator's promises of services and products are mostly true 5.05| 1.27

Lihde: Chiou and Droge, (2006); Harris and Goode (2004)

Action loyalty (Cronbach’s alpha: .876) Mean Sd

ACLL1. | regard myself as a loyal customer of my operator 5.34 | 1.60
ACL2. | think I'll stay a customer for my operator 5.26 | 1.53
ACLS6. There is no need for me to change my operator 5.64 | 1.42

Lahde: Harris and Goode (2004); Sousa and Voss (2006)

Recommend (Cronbach’s alpha: .896) Mean Sd
4. | tell other people positive things of my operator 4.37 | 1.66
5. | have recommended my operator to others 441 | 1.83

Léhde: Harris and Goode (2004); Sousa and Voss (2006)

Kyselylomaketta rakentaessa  kannattaa  mitata aiottuja  faktoreita =~ AIEMMIN
TESTATUILLA konstruktioilla EIKA KEHITELLA OMIA MITTAREITA (tai ainakin
olla varovainen uusien mittareiden kehittelyn kanssa). Eli rakenneyhtédlomallia rakennettaessa
kannattaa enemménkin testata olemassa olevaa teoriaa jolloin faktorit on helpompi valita ja

malli rakentaa kuin luoda omia malleja joita voi olla hankala perustella teorian kautta.

Seuraavaksi syntaksissa mééritellddn muuttujien aiotut faktorit ja faktoreiden véliset suhteet:

Relationships

ACL1 ACL2 ACL6 =ACL

ACL4 ACL5 = ACLR

CPS1 CPS2 CPS3 =CPS

SOVA1 SOVA2 SOVA3 =SOVA

TRU1 TRU2 TRU3 TRU4 TRU6 = TRU

REL1 REL2 REL3 REL4 RES1 RES2 RES3 RES4 ASS1 ASS2 ASS3 ASS4 =SQ

CPS =SQ
TRU = SQ
ACL = CPS

TRU = CPS SOVA
ACL =TRU CPS SOVA
ACLR = ACL

Ainoa asia mitd seuraavassa kohdassa:

LISREL OUTPUT: SC WLS MI MR AD=OFF
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Tarvitsee mahdollisesti muuttaa on WLS kohta joka tarkoittaa estimointimenetelméad. Yleensi
kaytettaviksi suositellaan ML (Maximum Likelihood) menetelmia, jolloin Lisrel ohjelmisto
valitsee automaattisesti hyvin soveltuvan estimointimenetelmén. Asymptoottista kovarianssi-
matriisia kdytettdessd (eli kun muuttujat eivdt noudata normaalijakaumaa) suositeltava esti-
mointimenetelmd on WLS (Weighted Least Squares) tai DWLS (Diagonally Weighted Least

Squares), joka antaa useimmiten parempia arvoja malleille.

Kun tdhin kenttddn on tehty tarvittavat asiat painetaan kohtaa ”Run Lisrel” (tai paina F5) jol-

loin avautuu graafinen rakenneyhtilomalli:

= LISREL Windows Application - [dna most items_23102007 _2.PTH]

DFiIe Edit Setup Draw View Image Output ‘Window Help

Dlc|es|m| & [%w[R| i3 SB]2
Groups: | J Models: |Basic Madel ﬂ Estimates: | Standardized S alution ﬂ
Observed | Y
COGL1 =] ACLA  |=0.12
CoGL2 L |
COGL3 ACLS
=017
COGLA 9-93/
AFFL1 /0-91
0,397 a.zo /
a_aoz S0WA2
Hg_gg/ ACL2 =+0_ 19
0.92 ) :
o o |
. ACLE  [™o.z2
o.z9 REL1
»
x 0.17 REL2 CPE |ea.zs
x 0_z74 REL3
x CP32  [=0.07
X REL4 .
0.13
»
x \ CP33  |=0_13
» o_30 RESL |
FUVA1
FUVAZ - 0.z7 RE 2
Latent |Eta
x| 4] a.17 RE 3 /- TRU1  |~0. 13
% / ;
x 0.z8 EE 34 ;
x 0.53 TRUZ [=0.12
TRU3 [=+0.17
TRU4 [=0.23
R ]
Chi-S8gquare=2261.25, df=341, P-walue==0.00000, EMIEA=0.064

KUVA 9. Graafinen rakenneyhtalomalli
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Kohdasta ”Estimates” kannattaa valita ensin Standardized Solution” jota tarkastelemalla saa
kokonaiskisityksen mallin toimivuudesta. Malli ndyttéisi toimivan sellaisenaan (RMSEA =
.064 -> hyvénd arvona pidetddn arvoja < .08. Mallista ndhddin ettéd teoreettisen mallin suhteet
ndyttdisivét patevdan myos empiirisessd mallissa. Kohdasta ”Output” -> "Fit Indices” ndhdadn
muut mallin kriittiset arvot joita on syyté tarkastella. Yleensd LISREL mallien tirkein tarkas-
teltava arvo on p-arvo, jonka pitéisi olla >.05 ettd malli toimisi. Suurilla aineistoilla (>200) p-
arvo kuitenkin ldhes poikkeuksetta lahenee 0.000 jonka vuoksi suurten otosten malleissa tar-
kastellaan 1ihinnd RMSEA:ta, mutta myos joitakin muita testisuureita voidaan hyodyntda

(olennaiset boldattuna):

Goodness of Fit Statistics

Degrees of Freedom = 341
Normal Theory Weighted Least Squares Chi-Square = 9768.88 (P = 0.9)
Satorra-Bentler Scaled Chi-Square = 2261.25 (P = 0.90)
Chi-Square Corrected for Non-Normality = 1887.01 (P = 0.0)
Estimated Non-centrality Parameter (NCP) = 1920.25
90 Percent Confidence Interval for NCP = (1773.49 ; 2074.43)
Minimum Fit Function Value = 2.29
Population Discrepancy Function Value (F@) = 1.39
90 Percent Confidence Interval for FO = (1.28 ; 1.50)
Root Mean Square Error of Approximation (RMSEA) = 0.064
90 Percent Confidence Interval for RMSEA = (0.061 ; 0.066)
P-Value for Test of Close Fit (RMSEA < 0.05) = 0.00
Expected Cross-Validation Index (ECVI) = 1.73
90 Percent Confidence Interval for ECVI = (1.62 ; 1.84)
ECVI for Saturated Model = 0.59
ECVI for Independence Model = 87.41
Chi-Square for Independence Model with 378 Degrees of Freedom = 120915.46
Independence AIC = 120971.46
Model AIC = 2391.25
Saturated AIC = 812.00
Independence CAIC = 121145.99
Model CAIC = 2796.42
Saturated CAIC = 3342.78
Normed Fit Index (NFI) = ©.98
Non-Normed Fit Index (NNFI) = ©.98
Parsimony Normed Fit Index (PNFI) = 0.89
Comparative Fit Index (CFI) = 0.98
Incremental Fit Index (IFI) = 8
Relative Fit Index (RFI) = O.
Critical N (CN) = 248.68
Root Mean Square Residual (RMR) = 0.071
Standardized RMR = 0.071
Goodness of Fit Index (GFI) = 0.99
Adjusted Goodness of Fit Index (AGFI) = 0.98
Parsimony Goodness of Fit Index (PGFI) = 0.83

0.
0.9
98

Lisrel out-tulosteen aluste tulee tarkistaa, ettei ohjelma ole skaalannut kovarianssi/korrelaatio

matriisia. Mikéli malli on hankalasti iteroitavissa, voi Lisrel ohjelmisto skaalata mallia kerto-
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malla kaikki kovarianssit/korrelaatiot jollain tietylld luvulla. Tdmaé selvidé tulosten alusta mi-
kali sielld lukee, ettd “taken ridge option”, tillin myos esimerkiksi laskennan perustana ol-
leen korrelaatiomatriisin korrelaatiokertoimet voivat olla itseisarvoltaan yli yksi. Mikéli oh-
jelma on suorittanut ’ridge option” toiminnon, tulee saadusta mallista erittdin epdvakaa (pie-
net muutokset voivat vaikuttaa valtavasti mallin hyvyys indekseihin) ja malliin tulisi suhtau-
tua silloin suurella varauksella. Téssd mallissa ko. ongelmaa ei esiinny, joten kuin jo aikai-
semmin todettiin, malli voidaan hyviaksyéd mikidli RMSEA < .08. Muut arvot (boldatut) pitiisi
olla >.90 ja SRMR arvon < .05. Malli tiyttda asetetut raja-arvot (lukuun ottamatta SRMR ar-
voa joka on hiuksen hienosti > .05 mutta asymptoottisen kovarianssimatriisin kohdalla SRMR
arvo usein on korkeahko) joten niin ollen malli voitaisiin arvojen perusteella hyviksyé. Tar-
kastellaan kuitenkin mallia vield silld silmélla etti voisiko sitd a) parantaa ja b) onko siiné jo-

tain perusteellista vikaa.

Mallista kannattaa miettid muuttujien poistamista jos niiden faktorilataus on alhainen (< .60)
ja/tai virhevarianssi (Error Variance) on suuri. Mallissa faktorilataukset ovat korkeita (>.79)
ja muuttujien virhevarianssi melko alhaisia (<.37) joten muuttujia poistamalla malli ei toden-
ndkoisesti juurikaan paranisi. Eikd se esimerkkitapauksessa ole tarkedtd koska malli on jo hy-
viksyttavissd. Mikéli yksittdisen muuttujan virhevarianssi (nékyy kuvassa muuttujan vieressa)
on suuri (>.40) muuttujan poistaminen mallista todenndkdisesti parantaa mallia. Kolmas lisi-
tarkastelu joka kannattaa jokaisen mallin kohdalla tehdd on valita ”Estimations” valikosta
kohta “t-values” josta ndhddén ovatko faktorilataukset ja faktoreiden viliset estimaatit (eli
regressiot) tilastollisesti merkitsevilla tasolla. Liséksi ndhdédén yksittdisten muuttujien kohdal-
ta virhevarianssin merkitsevyys. Mikéli t-arvon itseisarvo < 1,96 tarkoittaa se ettd t:n arvo ei
ole tilastollisesti merkitsevd. LISREL néyttii téllaiset arvot punaisella (Kuva 10). Kuten ku-

vasta ndhdéén kaikki mallin regressiosuhteet ovat tilastollisesti merkitsevid (> 1,96).

Mallin jatkotarkastelua varten kannattaa avata ikkuna “Estimates -> Modification Indices”
josta ndhdddn mitkd suhteet ovat ongelmallisia. N4itd suhteita vapauttamalla mallia voi paran-
taa mutta samalla menetetdéin vapausasteita eika titd toimintatapaa kovin usein suositella kéy-
tettdviksi. Vapautettavat virhekorrelaatiot on kuitenkin oltava teoreettisesti perusteltavissa, tai
muutoin mallin validiteetti huononee samalla kun reliabiliteetti paranee. Niin siksi, etti jos
mallissa on teoriaan kuulumattomia vaikutussuhteita, ei voida olettaa alkuperdisten vaikutus-
suhteiden olevan yhtd voimakkaita ja merkittdvia kuin uudessa mallissa. Modifikaatioindeksit

usein kertovat ettd esim. a) muuttujat lataavat usealle faktorille ja/tai b) samalle faktorille la-
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taavat muuttujat korreloivat erittdin vahvasti keskendin. Molemmista tapauksista aiheutuu
mallin toimivuuden kannalle ongelmia. Tastd kannattaakin katsoa sellaisia riippuvuuksia joita
poistamalla (poistetaan mallista ongelmallisia muuttujia) malli paranisi. Mitd suurempi modi-
fikaatioindeksin arvo on sitd parempi mallista yleensé tulee jos indeksi vapautetaan. Mikéli
indeksejd vapautetaan tulee tutkimusraportissa selittdd mallissa vapautettujen virhekorrelaati-
oiden teoreettiset merkitykset. Mikali teoreettisesti ei ole perusteltua vapauttaa virhetermien
korrelaatioita, ei ndin tulisi toimia. Adrimmdiseni esimerkkini voidaan mainita malli, josta
kaikki virhetermien korrelaatiot on vapautettu. Mallin reliabiliteetti on erittdin hyva, koska
malli 1dhenee saturoitua mallia, validiteetti puolestaan on surkea, koska mallin ei voida endi
viittdd mittaavansa alkuperdistd teoreettista mallia. Yleissdidntonéd kannattaa muistaa ettd mo-

difikaatioindeksejé ei tulisi vapauttaa vaan yrittdd kehittdd mallia muilla keinoin.

& LISREL Windows Application, - [dna most items_23102007_2.PTH]
DFiIe Edt Setup Draw View Image Output ‘Window Help

D[R] =% &[] /8|2
Groups: | J Models: |BasicModeI j Estimates: | T-values j

Observed | Y
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Chi-Square=21261.25, df=341, P-walue=0.00000, FM3SE2=0.064

KUVA 10. t-arvot
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Rakenneyhtalomallin tulosten raportointi

Tulokset suositellaan raportoitavan kahdessa osassa joista ensimmaisessd (Measurement mo-
del') kohdassa kuvataan havaittujen mittareiden ja niiden muodostamien faktoreiden rakenne
sekd kerrotaan mallin luotettavuus (reliabiliteetti ja validiteetti) ja suoritetaan muutkin hy-
vyystarkastelut. Aiemmin esitetyssd esimerkissd Measurement Model tarkastelu suoritettaisiin
siten ettd SIMPLIS koodissa ei tarkastella faktoreiden vilisid suhteita eli laitetaan niiden rivi-
en eteen huutomerkki seuraavasti (huutomerkki tarkoittaa etté ko. rivid ei tarkastella analyy-

sissa):

Observed Variables

COGL1 COGL2 COGL3 COGL4 AFFL1 AFFL2 AFFL3 AFFL4 AFFL5 CONL1 CONL2 CONL3 CONL4 ACL1
ACL2 ACL3 ACL4 ACL5 ACL6 CPS1 CPS2 CPS3 FUVAl1l FUVA2 FUVA3 FUVA4 EMOVAl1 EMOVAL2
EMOVAL3 EMVA4 SOVA1l SOVA2 SOVA3 TRU1 TRU2 TRU3 TRU4 TRU5 TRU6 REL1 REL2 REL3 REL4
RES1 RES2 RES3 RES4 ASS1 ASS2 ASS3 ASS4 EMP1 EMP2 EMP3 EMP4 EMP5 TAN1 TAN2 TAN3
TAN4

Correlation from file C:\Temp\dnal6cor

Asymptotic Covariance Matrix from file C:\Temp\dnal6acov

Sample size 1385

Latent Variables

COGL AFFL CONL ACL ACLR CPS FUVA EMOV SOVA TRU SQ LOY PEVA

Relationships

ACL1 ACL2 ACL6 = ACL

ACL4 ACL5 = ACLR

CPS1 CPS2 CPS3 = CPS

SOVA1 SOVA2 SOVA3 = SOVA

TRU1 TRU2 TRU3 TRU4 TRU6 = TRU

REL1 REL2 REL3 REL4 RES1 RES2 RES3 RES4 ASS1 ASS2 ASS3 ASS4 = SQ

ITRU = SQ (rivin alkuun huutomerkki jolloin sitd ei tarkastella)

ICPS = SQ (rivin alkuun huutomerkki jolloin sita ei tarkastella)
ITRU = CPS SOVA (rivin alkuun huutomerkki jolloin sitd ei tarkastella)
IACL = TRU CPS (rivin alkuun huutomerkki jolloin sita ei tarkastella)

IACLR = ACL SOVA (rivin alkuun huutomerkki jolloin sita ei tarkastella)
LISREL OUTPUT: SC WLS MI MR AD=OFF

Path Diagram

End of Problem

Ohjelma tulostaa faktorirakenteen jossa on mukana vain havaitut muuttujat eika faktoreiden
vilisid suhteita tdssd vaiheessa vield tarkastella. Tutkimusraportissa tissd osiossa on syyti

kertoa faktorilataukset, t-arvot sekd AVEt ja mittareiden reliabiliteettiarvot kuten jiljempana

esimerkissd kerrotaan.

Toisessa kohdassa (Structural model) kuvataan faktoreiden véliset suhteet eli kdydéan 1api

faktoreiden viéliset riippuvuudet (selitysasteet). Yleensé tdssd kohdassa vastataan esitettyihin

! http://www.ssicentral.com/lisrel/techdocs/MeasurementModelOutput.pdf
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tutkimushypoteeseihin. Pddpiirteittidin kerronta voisi olla seuraavanlainen (Karjaluoto et al.,
2007):
Measurement Model

Measurement model assessment

Following the recommendation made by Anderson and Gerbing (1988), we adopted a two-
step method to test (1) measurement model, and (2) structural model. First, in assessing the
measurement model, a confirmatory factor analysis (CFA) was conducted using LISRELS.7

(see Table 1).

Table 1: Factor Loadings for the Study Constructs

Measurement Item Unstandardized solution (t- Completely
model values shown in parentheses, standardized solution
all at p< .05)
Action loyalty ACL1 Tdhén estimaatit ja t-arvot Tahén faktorilataukset
ACL2
ACL6
Seuraava faktori Jne.

Reliability and validity of the model

Construct and discriminant validity

-tidssd kohdassa tarkastellaan mallin validiteettia

-sisdinen validiteetti (mittareiden lataukset faktoriin pitdd olla korkeita, Cronbach alpha ja
construct reliability)

-AVE > 0.5 (Another test on convergent validity involved an investigation of the average va-
riance extracted (AVE) of the constructs. A model can be considered to have good convergent
validity if at least 50 percent of measurement variance is captured by the construct (AVE >
0.5) (Fornell and Larcker 1981). The average variance extracted of all the constructs in the
model exceeded the cut-off criteria of 0.5 and ranged from 0.61 to 0.84, indicating good con-

vergent validity of the model. AVEs are shown in Appendix B”.

> LISREL ei laske AVEa vaan se pitii laskea esim. Excelin avulla oheisella kaavalla.
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Completely standardised Error variances Completely standardised
loadings (Lambda-X) (Theta-Delta) loadings squared (Lambda-X)

ACL1 0,79 0,37 0,624
ACL2 0,9 0,19 0,810
ACL6 0,84 0,29 0,706
TOTAL | 2,53 0,85 2,140
SQUARED| 6,401 4,578

Composite reliability 0,8828 Average variance extracted | 0,7157

KUVA 15. Mallin reliabiliteetin ja validiteetin laskeminen®

Laskentakaavat ovat seuraavat:

TOTAL: =SUM(ACL1:ACL6)

SQUARED: =SUM?

Composite reliability: =6,401/(6,401+0,85)
Average variance extracted: =2,140/(2,140+0,85)

To prove discriminant validity of the model we used a procedure proposed by Fornell and
Larcker (1981). They suggest assessing discriminant validity by investigating whether AVE
for the items is greater than their shared variance; that is, to examine whether the square root
of the AVE for a given construct is greater than the absolute value of the standardized correla-
tion of the given construct with any other construct in the analysis. ELI SUOMEKSI
TARKOITTAA ETTA AVE —arvosta otettu nelidjuuri pitaa olla suurempi kuin kysei-
sen faktorin korrelaatio muiden faktoreiden kanssa. Esim. seuraavassa taulukossa AVE —
arvoista otetut nelidjuuret nékyvit tummennettuina. Kuten ndhdién arvot ovat suurempia kuin

kyseisen faktorin korrelaatiot muiden faktoreiden kanssa joten mallin validiteetti on hyvai).

3 Klikkaamalla taulukkoa padset syottdmadn tarvitut arvot (16ytyvat LISRELin .OUT tiedos-
tosta kun malli identifioidaan). Excel pohja laskee automaattisesti ”Composite reliability”’:n
sekd AVE:n
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Correlation matrix of the constructs, AVEs and square root of the AVEs (on the diagon-
al)

AVE ACL ACLR CPS TRU SOVA SQ

ACL .72 0.85

ACLR 63 0.76 0.79

CPS 72 0.68 047 0.85

TRU .72 0.71 0.65 0.69 0.85

SOVA .74 030 0.49 0.08 0.59 0.86

SQ .90 030 027 032 040 024 0.95

Structural model assessment and hypotheses tests

-Téasséd kohdassa kerrotaan mallin arvot ja faktoreiden véliset suhteet.

Esim.

The model fit was good (chi square = 2,261.25 (df=341), p = .00; CFI = .98; NNFI = .98; IFI
= .98; GFI = .99, AGFI = .98; RMSEA = .05, standardized RMR = .07) (Bollen 1989;
Browne and Cudek 1993; Hu and Bentler 1995). While the chi-square statistic becomes prob-
lematic with large samples, other indices like RMSEA should be used to assess model fit (Di-
amantopoulos and Siguaw 2000; Ullman and Bentler 2004). The RMSEA statistic for the
model was below the cut-off criteria of .08 indicating a close fit of the model (Browne and
Cudek 1993; Byrne 1989). The model is shown in Figure 2. The numbers represent the stan-

dardized path coefficients (t values are shown in parentheses).

Action Recommend
loyalty

ST(10.33)

Service
cualitsy

Customer

perceived
sacrifices

KUVA 16 Structural model
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-hypoteesien testaus:

The hypotheses were tested by investigating the path coefficients, which shows the complete-
ly standardized LISREL estimates and their respective t values. As it can be seen, all the paths
were statistically significant. Thus, there seems to be support for all the hypotheses. However,

there was significant variation in the strength of the paths, which requires further explanation.
H1 contends that there is a positive and direct relationship between... The path coefficient (

= .32) is very strong with a high t value (14.67) indicating that service quality has a strong

positive association with the customer perceived sacrifices. ...
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